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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent
electromagnetic compatibility (EMC) and safety standards as described in the next section or sections by product name.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards.
Changes to your system include replacing a part or adding components, options, or peripherals not specifically
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards,
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific
or one of its authorized representatives.

FCC Compliance Statement

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED,
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

f:i CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside

this manual pertaining to the safe use and operation of this product before using the device.

Notice on Lifting and Handling of

Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher
Scientific instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or
bulky for one person alone to handle safely.



Notice on the Proper Use of

Thermo Scientific Instruments

In compliance with international regulations: This instrument must be used in the manner specified by Thermo Fisher
Scientific to ensure protections provided by the instrument are not impaired. Deviations from specified instructions on
the proper use of the instrument include changes to the system and part replacement. Accordingly, order replacement
parts from Thermo Fisher Scientific or one of its authorized representatives.

Notice on the Susceptibility

to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE)
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermoscientific.com/

rohsweee for further information on Thermo Fisher Scientific’s compliance with these Directives and the recyclers in
your country.

WEEE Konformitat

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfiillen.
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information
tiber die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, tiber die Verwerter, und weitere Hinweise,
die niitzlich sind, um die Produkte zu identifizieren, die unter diese RoOHS Anweisung fallen, finden sie unter
www.thermoscientific.com/rohsweee.
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Conformité DEEE

Ce produit doit étre conforme a la directive européenne (2002/96/EC) des Déchets d'Equipements Electriques et
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de
'union européenne et ce produit devrait étre collecté ou recyclé par celles-ci. Davantage d'informations sur la
conformité de Thermo Fisher Scientific a ces directives, les recycleurs dans votre pays et les informations sur les

produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes a la directive RoHS sont
disponibles sur www.thermoscientific.com/rohsweee.
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Preface

This guide describes how to connect a CTC™ Thermo PAL™ autosampler to other devices in
the liquid chromatography/mass spectrometry (LC/MS) system and how to control the
autosampler from a Thermo Scientific™ mass spectrometry application, such as the Xcalibur™
data system.

ThermoPAL, one of the device drivers provided on the Thermo LC Devices DVD, is the
device driver that enables the Xcalibur data system to control the autosampler.

Contents

* Related Documentation

* System Requirements

* Supported Firmware Versions
* Safety and Special Notices

* Contacting Us

< To suggest changes to documentation or to Help

Complete a brief survey about this document by clicking the button below.
Thank you in advance for your help.

SURVEYl

Thermo Scientific Thermo PAL User Guide ix
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Related Documentation

In addition to this guide, the Thermo PAL autosampler includes Help.

< To view product manuals

For an LC instrument controlled by a Thermo Scientific software application, choose
Start > All Programs (or Programs) > Thermo Instruments > Manuals > LC Devices >

CTC.

For the Xcalibur manual set, choose Start > All Programs (or Programs) >
Thermo Xcalibur > Manuals > Xcalibur.

< To open Help

* From the Thermo Xcalibur Instrument Setup window, choose Help > Thermo Pal

Help.

¢ Ifavailable for a specific window or dialog box, click Help or press the F1 key for
information about setting parameters.

For more information, visit www.thermoscientific.com.

System Requirements

X

Thermo PAL User Guide

Table 1 lists the system requirements for the Thermo PAL autosampler drivers provided on

the DVDs for LC Devices 2.5.0 or later.

IMPORTANT Before you install the device drivers provided on the LC Devices DVDs,
ensure that the data system computer has a compatible version of the

Thermo Foundation™ platform as noted in the 7hermo LC Devices x.x.x Release Notes,
where x.x.x is the version you want to install. You can find the Release Notes, which
includes the system requirements, on the LC Devices DVD.

Thermo Scientific
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Table 1. System requirements

System

Computer

Minimum requirements

* 2 GHz processor with 1 GB RAM

DVD drive
80 GB available on drive C
Video card and monitor capable of 1280 x 1024 resolution

Network interface cards, two
NTFS format

Preface

Software

Adobe™ Reader™ 9.0

Microsoft™ Windows™ operating system:

— Windows 7 Professional (32-bit and 64-bit?)
—  Windows XP Workstation SP3

Thermo Scientific software:

LC Devices Foundation

2.6.0 and later 1.0.2 SP2 and later
2.5.0 SP3 1.0.2 SP2

2.5.0 SP1 or SP2 2.0

2.5.0 1.0.2 SP2

4LC Devices 2.8.0 and later are compatible with Windows 7, 32-bit and 64-bit

(Windows 7 only) If you receive a server failure error when you try to open the Xcalibur

Instrument Setup window, follow the next procedure.

< Toresolve a server failure for the Xcalibur data system

1. Verify that the installed versions of Thermo Foundation and LC Devices are compatible

(see Table 1).

2. If the installed LC Devices software is compatible with Foundation, go to step 3. If it is

not compatible, do the following:

a. Use the Windows Control Panel to uninstall all of the modules from LC Devices.

b. Install the compatible version of LC Devices.

c. Restart the data system computer.

Thermo PAL User Guide xi
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3. If the installed LC Devices is compatible with Foundation, do the following:
a. Open the Windows Control Panel.

b. In the top Search box, type Change User Account Control Settings, and then select
this link to open the User Account Control Settings dialog box.

c.  Move the slider to the Default position (Figure 1).
d. Click OK.

Figure 1.  User Account Control Settings dialog box

'@ User Account Control Settings EI@

s

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs frem making
changes to your computer.

Tell me moere about User Account Control settings
Always notify

- - Default - Notify me only when
programs try to make changes to my
computer

m

| ol B L ® Don't notify me when I make
changes to Windows settings

Slider set at the
Default position

@ Recommended if you use familiar —
pragrams and visit familiar
- - websites.

MNever notify

[ oK ][ Cancel

Supported Firmware Versions

LC Devices supports firmware versions 2.4.0, 2.5.2, 4.1.2, and 4.1.3 for the Thermo PAL

autosampler.

xii Thermo PAL User Guide Thermo Scientific



Safety and Special Notices

Contacting Us

Thermo Scientific

Preface

Make sure you follow the precautionary statements presented in this guide. The safety and
other special notices appear in boxes. Safety and special notices include the following.

CAUTION Highlights hazards to humans, property, or the environment. Each CAUTION
notice is accompanied by an appropriate CAUTION symbol.

IMPORTANT  Highlights information necessary to prevent damage to software, loss of
data, or invalid test results; or might contain information that is critical for optimal

performance of the system.

Note Highlights information of general interest.

Tip Highlights helpful information that can make a task easier.

There are several ways to contact Thermo Fisher Scientific for the information you need.

R
0’0

To contact Technical Support

Phone 800-532-4752
Fax 561-688-8736
E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com
Web site www.thermo.com/ms

To get local contact information for sales or service

Go to www.thermoscientific.com/wps/portal/ts/contactus.

Thermo PAL User Guide
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< To copy manuals from the Internet

Go to mssupport.thermo.com, agree to the Terms and Conditions, and then click
Customer Manuals in the left margin of the window.

< To suggest changes to documentation or to Help
* Fill out a reader survey online at www.surveymonkey.com/s/PQMG6PG62.

* Send an e-mail message to the Technical Publications Editor at
techpubs-lems@thermofisher.com.

Xiv Thermo PAL User Guide Thermo Scientific
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Getting Connected

The CTC Thermo PAL is a high-throughput autosampler manufactured by CTC Analytics
and supplied by Thermo Fisher Scientific. For high-throughput LC/MS applications, use the
PAL autosampler, a Thermo Scientific or an Agilent™ liquid chromatography (LC) pump,
and a Thermo Scientific mass spectrometer (MS).

This chapter describes the contact closure connections between the PAL autosampler, one or
two Thermo Scientific LC pumps or an Agilent pump, a Thermo Scientific mass
spectrometer, and the Xcalibur data system computer. For information on how to set up the
PAL autosampler, refer to the CTC Analytics PAL System User Manual.

the CTC Analytics PAL System User Manual. The Safety Information section includes
information on the autosampler’s electrical hazards, lithium battery, and safety labels.

f CAUTION Follow all of the recommendations given in the Safety Information section of

Contents

* Ordering Information
* Setting Up an LC/MS System with the Autosampler

* Connecting the Thermo PAL Autosampler to the Data System
Computer

* Connecting the Contact Closure Cables

Ordering Information

Thermo Fisher Scientific supplies these cables with the Thermo PAL autosampler:
* Serial communication cable that connects the autosampler to the data system computer

* Contact closure cable that connects the autosampler to the Thermo Scientific LC pump
and Thermo Scientific mass spectrometer

Thermo Scientific Thermo PAL User Guide 1



1 Getting Connected

Setting Up an LC/MS System with the Autosampler

To order the HTC PAL or HTS PAL autosampler from Thermo Fisher Scientific, see Table 2.

Table 2. Thermo PAL ordering information

Description Part number

HTC PAL OPTON 13009
HTC PAL with the 98 x 2 mL tray holder OPTON 13010
HTS PAL OPTON 13008

Table 3 lists the contact closure cables used to connect an Agilent pump to a Thermo
Scientific mass spectrometer and the autosampler. You can order the DB15 connector x 15
wire cable from Agilent or Thermo Fisher Scientific.

Table 3. Contact closure cables used to connect an Agilent pump

Description Supplier Part number
DBI15 connector x 15 wire cable Thermo Fisher Scientific ~ 00012-27716
DB15 connector x 15 wire cable Agilent G1103-61611
PAL Interface Cable for APG Remote CTC Analytics CBL 7890

DB15 connector x DB9 connector cable

Setting Up an LC/MS System with the Autosampler

A

2 Thermo PAL User Guide

Typical stackable setups include placing the autosampler on top of the two pumps, in a
dual-pump setup, and to the left of the mass spectrometer. Ensure that the stackable area for
the autosampler is level, and that system cables behind the autosampler have adequate space.

CAUTION To prevent damage to the injection unit during operation, place the
autosampler on a level surface.

For information on how to assemble the Thermo PAL autosampler and connect the solvent

lines, refer to the CTC Analytics PAL System User Manual.

Figure 2 shows the front view of the Thermo PAL autosampler. During installation, the
Thermo Fisher Scientific field service engineer connects the following:

* LC system to the mass spectrometer

* Solvent lines from the injection valve to the LC pump and the Thermo Scientific mass
spectrometer

Thermo Scientific



1 Getting Connected
Setting Up an LC/MS System with the Autosampler

Figure 2. PAL autosampler (supplied by Thermo Fisher Scientific)

Courtesy of CTC Analytics

Injection unit

Control terminal

Syringe
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1 Getting Connected

Connecting the Thermo PAL Autosampler to the Data System Computer

Connecting the Thermo PAL Autosampler to the Data System

Computer

Thermo PAL User Guide

The Thermo PAL autosampler communicates with the data system computer through the
supplied RS-232 serial communication cable.

< To connect the autosampler to the data system computer

Using the RS-232 serial cable supplied with the autosampler, connect the SER 1 port on
the back of the autosampler to the serial port on the back of the data system computer
(Figure 3 and Figure 4).

Figure 3. Data system connection (firmware 2.5.2)

Data system

computer
Autosampler g g j
[ [ s $
® @® ® ®
P —
o (- o
® ® ®
s (7

DB9 to DB9
serial cable
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1 Getting Connected
Connecting the Contact Closure Cables

Figure 4. Data system connection (firmware 4.1.2)
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computer
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Connecting the Contact Closure Cables

During an injection cycle, the Thermo PAL autosampler sends and receives electrical signals.
To start an injection cycle, the autosampler must receive a signal from the LC pump. When
the autosampler completes an injection cycle, it sends a signal back to the LC pump. For more
information about interfacing the autosampler with other devices, refer to the CTC Analytics
PAL System User Manual (Interfacing the PAL to Other Devices section).

This section describes how to hardwire one or two LC pumps and a Thermo Scientific mass
spectrometer to the autosampler for contact closure.

To make the contact closure connections, follow the procedure for your LC/MS system:
* Making Contact Closure with Thermo Scientific Devices
* Connecting the Start Pump to the Sample Pump in a Dual-Pump System

* Dual-pump setup with two Accela Pumps

Thermo Scientific Thermo PAL User Guide 5



1 Getting Connected
Connecting the Contact Closure Cables

Making Contact Closure with Thermo Scientific Devices

The accessory kit supplied by Thermo Fisher Scientific contains the contact closure cables
that you need to connect the Thermo PAL autosampler to an LC/MS system with one or two
Thermo Scientific LC pumps and a Thermo Scientific mass spectrometer.

Figure 5 shows the Thermo Single Configuration cable assembly that you use to connect one
LC pump and a Thermo Scientific mass spectrometer to the autosampler. The cable assembly
consists of a DB15 connector with two 2-pin legs. One leg connects to the LC pump, and the
other leg connects to the mass spectrometer. During the installation of the LC/MS system, a
Thermo Fisher Scientific field service engineer uses the appropriate mini COMBICON™
connectors to complete the contact closure cable assembly, and then connects the assembly to
the appropriate pins on the LC pump or LC pumps and the mass spectrometer.

Figure 5. Contact closure cable for LC/MS with one Thermo Scientific LC Pump

300 cm
<€ (10ft)

Clear

’:' ?]Cbl Thermo Single Config. D:@

09
o
o
o
o
o
o
o
o
o
o
OO
o

< To connect the contact closure cable to the LC pump and the MS

1. Connect the DB15 connector of the contact closure cable to the DB15 port on the back
of the autosampler.

The port label depends on the autosampler model (see Table 4).

Table 4. PAL contact closure port

PAL model Port marking
HTC, LC INTERFACE
HTS INTERFACE 1

6 Thermo PAL User Guide Thermo Scientific
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1 Getting Connected
Connecting the Contact Closure Cables

2. Using an 8-pin COMBICON connector, connect one leg of the contact closure cable to
the appropriate pins on the back panel of the Thermo Scientific LC pump (see Table 5).

Table 5. Contact closure cable connection to Thermo Scientific pump

Pump model Clear wire Black wire
Accela Pump GRAD START (pin 4) GND

Surveyor LC Pump Plus PROG. START (pin 4) GND
Surveyor MS Pump Plus GRAD START (pin 8) GND

3. Using a 2-pin COMBICON connector, connect the other leg of the contact closure cable
to the Start in pins on the Thermo Scientific MS.

Figure 6 shows the contact closure connection between the autosampler and a Thermo
Scientific LC pump, and Figure 7 on page 9 shows the contact closure connection between
the autosampler and a Thermo Scientific mass spectrometer. (Figure 6 is for firmware 2.5.2
and Figure 7 is for firmware 4.1.2.)

Thermo PAL User Guide 7



1 Getting Connected
Connecting the Contact Closure Cables

Figure 6. Contact closure connections to a Thermo Scientific LC pump and MS (firmware 2.5.2)
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1 Getting Connected
Connecting the Contact Closure Cables

Figure 7.  Contact closure connections to a Thermo Scientific LC pump and MS (firmware 4.1.2)
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1 Getting Connected
Connecting the Contact Closure Cables

Connecting the Start Pump to the Sample Pump in a Dual-Pump System

In a dual-pump system, the start pump triggers the sample pump.

To connect the start pump to the sample pump, you can use the contact closure cable that
CTC Analytics supplies, or you can use one insulated electrical wire to connect the ground

pins and one insulated electrical wire to connect the GRAD START or PROG. START pins.

Figure 8 shows the contact closure cable that you can order from CTC Analytics.

Figure 8. Contact closure cable (supplied by CTC Analytics) used to connect two LC pumps

100 cm
< (39 inches)

= I T T o e

< To make contact closure for a dual-pump system

1. Connect the DB15 connector of the Thermo Single Config cable to the INTERFACE 1
or INTERFACE port on the back panel of the autosampler.

2. Connect one of the 2-pin legs of the Thermo Single Config cable to the start pump.

3. Connect the other 2-pin leg of the Thermo Single Config cable to the Thermo
Scientific MS.

4. Connect the start pump to the sample pump:

* Connect the start pump ground pin to the sample pump ground pin.

* Connect the GRAD START or PROG. START pin on the start pump to the GRAD
START or PROG. START connection on the sample pump.

Table 5 on page 7 lists the pin assignments of the Accela Pump, the Surveyor MS
Pump Plus, and the Surveyor LC Pump Plus.

Figure 9 shows two Accela Pumps connected together for contact closure.

10 Thermo PAL User Guide Thermo Scientific



1 Getting Connected
Connecting the Contact Closure Cables

Figure 9. Dual-pump setup with two Accela Pumps
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1 Getting Connected
Connecting the Contact Closure Cables

Making Contact Closure with the Autosampler, an Agilent Pump, and a Mass
Spectrometer

To make contact closure between the autosampler and an Agilent pump and between an
Agilent pump and a Thermo Scientific mass spectrometer, you must have the following
cables:

* PAL interface cable (supplied by CTC or Agilent) for an Agilent pump (Figure 10)

* External contact trigger cable supplied by Thermo Fisher Scientific (Figure 11)

< To make contact closure between the autosampler, an Agilent Pump, and a Thermo
Scientific MS

1. Using the PAL interface cable (Figure 10), connect the Agilent pump to the autosampler

as follows (Figure 12 on page 14 [firmware 2.5.2] and Figure 13 on page 15 [firmware
4.1.2]):

¢ Connect the DB15 connector to the INTERFACE (HTC) or INTERFACE 1
(HTS) port on the back panel of the Thermo PAL autosampler.

* Connect the DB9 connector to the REMOTE port on the back panel of the Agilent
pump.
Figure 10. PAL interface cable for an Agilent pump (supplied by CTC Analytics)

170 cm
(5.6 ft %

5 O
)
o
o
o
()
o
)
o
o
o
00
o

—
ETLE

INTERFACE 1

Connect to the Connect to the Agilent pump

autosampler

2. Using the external contact trigger cable (Figure 11), connect the Agilent pump to the
mass spectrometer (Figure 12 on page 14 [firmware 2.5.2] and Figure 13 on page 15
[firmware 4.1.2]):

* Connect the DB15 connector to the RELAY CONTACTS port on the back of the
Agilent pump.

For information on how to install the external contact board, refer to the Agilent xxxx
Series Getting Connected Guide, where xxxx is your specific Agilent LC system.

* Connect the white wire to the Start In pin and the brown wire to ground on the MS.
Secure the remaining 13 wires to the cable with duct tape.
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1 Getting Connected
Connecting the Contact Closure Cables

Figure 11. External contact trigger cable (supplied by Thermo Fisher Scientific)
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Figure 12. Contact closure with an Agilent pump, the autosampler, and a Thermo Scientific MS (firmware 2.5.2)
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Figure 13. Contact closure with an Agilent pump, the autosampler, and a Thermo Scientific MS (firmware 4.1.2)
Surveyor MSQ Plus MS TSQ Series MS LTQ Series MS
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Getting Started

This chapter describes how to add the autosampler to the Xcalibur instrument configuration,

how to specify the available tray types, and how to specify the injection parameters for the
autosampler from the Xcalibur data system.

Contents
* Configuring the Thermo PAL Autosampler
* Using the Autosampler Control Terminal

* Specifying the Instrument Method Parameters

Configuring the Thermo PAL Autosampler

The ThermoPAL device driver provides control of the autosampler from the Xcalibur data
system. To control the autosampler from the data system, add the autosampler to the Thermo
Foundation Instrument Configuration window and specify its configuration options.

R

< To add the autosampler to the Foundation instrument configuration

1. Turn on the autosampler.

2. From the Microsoft Windows taskbar, choose Start > All Programs (or Programs) >
Thermo Foundation x.x > Instrument Configuration, where x.x is the installed version
of Thermo Foundation, to open the Thermo Foundation Instrument Configuration
window (Figure 14).
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Figure 14. Thermo Foundation Instrument Configuration window

Thermo Foundation Instrument Configuration @
Device Types :
Al -
Awailable Devices: Corfigured Devices:

| »

m

Themo Pal Accela 1250 Pump

Velos Pro MS

l Add =» ] l <« Remove ] l Configure

[ Done ] [ Help ]

3. Under Available Devices, double-click the autosampler icon to add it to the Configured
Devices area.

Use the Pal Configuration dialog box to select the PC Com port where the autosampler is
connected, specify macros to import, and select sample trays or stacks.
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< To specify the configuration options for the autosampler

1. Follow the procedure “To add the autosampler to the Foundation instrument
configuration” on page 17.

2. In the Instrument Configuration window, under Configured Devices, double-click the
autosampler icon, and then do the following on the displayed page (Figure 15).

Figure 15. Pal Configuration dialog box

Pal Configuration
Communications

Com Port: _ -
Cancel
Auto Select | Check. |
Help
Look Ahead [njections tethod Template % Macro Editor
Enable: r Enable: ~
Cycle Composer bacro Inmparter
Import Path; |C:4
Ovenwrite exisiing macros; |Mewver = Import | Browse... |
Active Traps
Tray Wame | Stack | Allow Use | =
Trayp01 Stackl ez = |
Tray02 Stackl ez o
Tray03 Stackl ez
Tray0d Stackl ez
Tray0s Stackl ez i
q |F T == e

3. Under Communications, do the following:
a. In the Com Port list, select the communication port on the data system computer

that the autosampler connects to. Or, click Auto Select.

Note The auto-select feature works only if the autosampler is connected to the
data system computer and is turned on.

b. If the autosampler is already connected to the data system computer, click Check to
verify the connection.

4. Under Look Ahead Injections, to shorten the time between injections, select the Enable
check box.

Tip Do not modify or delete a sequence while the data system is running with the
Look Ahead Injections enabled. Use the stop function to finish the current injection
before you modify or delete a sequence.

5. Under Method Template\Macro Editor, to make the Method Template and Macro Editor
dialog boxes available in the Instrument Setup window, select the Enable check box.
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6. Under Cycle Composer Macro Importer, import the macros that you plan to use to create

injection methods as follows:

a. In the Import Path box, type the complete path to the location of the macros. Or,
click Browse to locate the directory that contains the appropriate macros.

b. In the Overwrite Existing Macros list, select one of the following:

* Never—The autosampler does not import the specified macro if it has the same
file name as an existing macro.

* Ask—The autosampler asks you if you want to overwrite existing macros.

* Always—Imported macros overwrite existing macros.

c. Click Import.

. Under Active Trays, select the trays that you want to use.

You can use trays that have a Yes in the Allow Use column. Clicking the tray name clears
the Allow Use cell and removes the tray from the list of available trays in the Xcalibur data
system.

IMPORTANT Use the autosampler control terminal to specify the tray information.
You can change the tray information when you control the autosampler from the
Xcalibur data system, but these changes are temporary. When you close and reopen
the Xcalibur data system, the tray information resets to the autosampler control
terminal settings.

. Click OK.

. Configure the other instruments in the LC/MS system, such as the LC pump and the

mass spectrometer.

10. In the Thermo Foundation Instrument Configuration window, click Done.

Table 6 lists the parameters for the Pal Configuration dialog box.
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Table 6. Pal Configuration dialog box parameters (Sheet 1 of 2)

Parameter Description

Communications

Com Port Select the computer port where you plug the autosampler
communication cable.

Auto Select Instructs the system to automatically determine the computer
port that connects to the autosampler through the
autosampler communication cable.

Check Instructs the system to verify the computer port that connects
to the autosampler through the autosampler communication
cable.

Look Ahead Injections

Enable Select this check box to enable Look Ahead Injections.

When enabled, the autosampler sets up for the next injection
during the current run. The setup for the next injection
involves carrying out the steps up to, but not including, the
injection.

Method Template \ Macro Editor

Enable Select this check box when you want the Method Template
and Macro Editor to be accessed through Instrument Setup.
Ensuring the check box is clear prevents access to the Method
Template and the Macro Editor.

Cycle Composer Macro Importer

Import Path Enter the path to the Cycle Macro to be imported.

Overwrite Existing Macros ~ Select Never, Ask, or Always.

The selection determines if existing macros are to be
overwritten when a new macro is imported.

Import Import the chosen macro.

Browse Search through files and folders to find a macro.
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Table 6. Pal Configuration dialog box parameters (Sheet 2 of 2)

Parameter Description

Active Trays

Tray Name Hardware configured tray names.
Stack Stack location of a given tray name.
Allow Use Click to switch between Yes and blank.

* “Yes” means that the PAL system can access a given tray
for obtaining samples (use is allowed).

* A blank means that the PAL system cannot access the tray
for obtaining samples (that is, use is not allowed).

Using the Autosampler Control Terminal

For general information about using the autosampler control terminal, refer to the C7C PAL
System User Manual.

To select the sample trays and to change the default pulse time setting to 4.0 seconds, follow

these procedures:
* Selecting the Tray Type

* Changing the Pulse Time Setting

22 Thermo PAL User Guide Thermo Scientific



Selecting the Tray Type

Thermo Scientific

2 Getting Started
Using the Autosampler Control Terminal

< To select the tray type

1. On the Job Queue screen, select Menu by pressing the F1 key (Figure 16).

Figure 16. Autosampler control terminal with the Job Queue screen displayed

Menu Ins Del | Pause
Job Job
F1 || F2 || F3 || Fa

Inner knob

Q (button)

ESC <::> STOP

Outer knob

2. From the Menu screen, open the Tray screen as follows:

a.

Rotate the outer knob to move the cursor bar (highlight) to Setup, and then press the
inner knob (button).

Rotate the outer knob to move the cursor bar to Objects, and then press the inner

knob (button).

Rotate the outer knob to move the cursor bar to Trays, and then press the inner knob
(button).

The Trays screen lists the available trays.

3. Select a tray as follows:

a.

Rotate the outer knob to move the cursor bar to the tray that you want, and then
press the inner knob (button).

The screen now shows the Tray Type.
Make the Tray Type active by pressing the inner knob (button) again.

The Tray Type is highlighted.
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c. Rotate the outer knob to select the tray type. Select NONE if no tray is present
(rotate the outer knob until NONE appears as the Tray Type).

d. Press the inner knob (button) to make the selection.
4. Repeat step 3 for all the trays to be used.

5. Return to the Job Queue screen by pushing the F4 key (Home) on the control terminal.

Changing the Pulse Time Setting

24

Thermo PAL User Guide

To control LC systems with a Thermo Scientific LC pump and an autosampler from the
Xcalibur data system, you must change the default pulse time setting for the autosampler from
2 to 4 seconds. The pulse time is the length of time that the autosampler sends an output
signal after it makes an injection. The LC pump receives this output signal through the
contact closure cable.

IMPORTANT If your LC system contains a Thermo Scientific LC pump and an
autosampler, you must change the autosampler’s default pulse time setting. If you leave
the default pulse time set to 2 seconds, the status of the LC pump remains at waiting for
contact closure after you make an injection.

Change the pulse time setting to 4.0 seconds from the Injected screen (Figure 17).

Figure 17. Menu path to Injected screen

I:l Menu
|:| Setup
|:| Objects
|:| Out Signals

I:I Injected
________Injected |

Destination SW-Out1

Pulse Time m

Oms...9.9s

Set Home
Deflt
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< To change the pulse time setting
1. Open the Injected screen as follows:
a.  On the Job Queue screen, press the F1 key to select Menu (Figure 16 on page 23).

b. Rotate the outer knob to move the cursor bar (highlight) to Setup, and then press the
inner knob (button).

c. Rotate the outer knob to move the cursor bar (highlight) to Objects, and then press
the inner knob (button).

d. Rotate the outer knob to move the cursor bar (highlight) to Out Signals, and then
press the inner knob (button).

e. Rotate the outer knob to move the cursor bar (highlight) to Injected, and then press
the inner knob (button) to display the Injected screen (Figure 17 on page 24).

2. Rotate the outer knob to move the cursor bar (highlight) to Pulse Time, and then press
the inner knob (button) to highlight the time cell.

3. Rotate the outer knob to change the pulse time to 4.0 seconds, and then press the inner
knob (button) to set this selection as the default.

4. Press the F4 key (Home) to return to the Job Queue screen.

Specifying the Instrument Method Parameters

To inject a sample set automatically, you must create an instrument method that contains the
chromatographic conditions and mass spectrometer data acquisition settings, and then create
an acquisition sequence that specifies the instrument method and vial location for each run.

This section describes how to specify the basic instrument method parameters for the
autosampler. For information on how to create acquisition sequences, refer to the Xcalibur
Sequence Setup view Help topic.

Thermo Scientific Thermo PAL User Guide 25



2 Getting Started
Specifying the Instrument Method Parameters

Creating an Instrument Method
This section provides information about how to create an instrument method.

< To specify the instrument method parameters for the autosampler

m't ' 1. Choose Start > All Programs (or Programs) > Thermo Xcalibur > Xcalibur, and then
o click the Instrument Setup icon to open the Instrument Setup window.

Note The Instrument Setup window might take several seconds to open. If you
receive a server failure error, follow the instructions on page xi.

2. Click the autosampler icon to open its Instrument Setup window.

3. Click the Method Setup tab to open the Method Setup page (Figure 18).

Figure 18. Method Setup page for the autosampler (before you select a template)

Methed Setup | Method Summary |
Template Selection

Template | ~ | Method Folder evices\ThemoPAL\PAL'\Methods'  Browse...

Template Description Macro
Wariables

Syringe
| =

Macro Seguence

Recommended Injection Volume
Volume () 1.000

Look Ahead Injections

Delay Time {mins) [0.00 Help | |

4. Under Template Selection, click Browse to open the Browse for Folder dialog box, and
then browse to the following folder that contains the autosampler methods (.pme
extension):

drive\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Methods
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5. In the Template list, select a template that represents the task that you want to do.

The autosampler comes with these templates:

e DLW Priming_Rev01l.pme * Multi Step LC Injection.pme
e LC-Inj DLW Fast_Rev03.pme * Single Step LC Injection.pme
e LC-Inj DLW Standard_Rev03.pme * Startup-Shutdown.pme

* Thermo PAL.pme autosampler (comprised of three templates):
—  Multi Step LC Injection.pme
—  Single Step LC Injection.pme
—  Startup-Shutdown.pme
If you ordered the DLW option with the autosampler, you can also select the DLW

templates.

CAUTION Do not use the three DLW templates if you did not order the DLW option
fji with your autosampler. Using these templates for the Thermo PAL autosampler

without the DLW option could cause damage to the instrument and cause the
injection to not perform any washes at all.

IMPORTANT  If you select a DLW template, make sure the Rear Volume +
Injection Volume + Front Volume + 2x Airgap is less than the syringe size. Otherwise
it will result in Error 86 (Syringe Volume Out of Range).

In addition to these templates, you can create your own custom templates (see “Using the
Template Editor to Create Custom Templates” on page 35). When you store a custom
template in the same folder as the standard templates, the template appears in the
Template list.

Figure 19 shows the macro sequence and the macro variables for the
Single Step LC Injection template.
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Figure 19. Method Setup page on the Instrument Setup window with the LC-Inj template

Macro sequence
for the Single Step
LC Injection template

Variable list
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Method Setup | Method Summary |
Template Selection

Template |\Them10\|nstn.|rnents\LC Devices' Themo PALYP AL \Methods"Single Step LC Injection pme  Mew Template

Template Description

Duplication of PAL local LC-Inj -
cycle.

This is onhy @ sample method for
short runs. For analtical work the
method parameters must be set
according to the specific needs.

Syringe
| 100ul |

Macro Sequence

— [

Macro "LC-Inj", 1of 1
Variables

Air Yalurme [pl)

Fre Cleat with Solvent 1
Fre Clean with Salvent 2
Pre Clean with Sample
Filling Speed [pliz)

Filling Strokes

Inject to

Injection Speed [plz)

Fre Inject Delay [mz)
Poszt Inject Delay [mz)
Piost Clean with Solvent 1
Pzt Clean with Sobvent 2
Yalve Clean with Solvent 1

Yalve Clean with Solvent 2

Recommended Injection Yalume
YWolume: (1) 10.000

Look Ahead Injections

Delay Time (ming) |0.00

Help

|LC Wit

[100

|500

|500

1

|0

1

|1

Default Al

When you select a template, the macros used by the template appear in the Macro

Sequence area. When you click on a macro listed in the Macro Sequence area, the

variables used by the Macro appear in the Variables area.

. Under Variables, keep the parameters set to the defaults, or type the appropriate values for

your application.

. From the Syringe list, select the syringe size that is installed in the autosampler.

The default variable settings for the Single Step LC Injection template and the default
setting of 10 pL in the Recommended Injection Volume box are suitable for a 100 pL
syringe. Changing the syringe size can change the allowable ranges for the recommended

injection volume and the variables specified in the LC-Inj macro.
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IMPORTANT Make sure that the syringe selection matches the size of the installed
syringe.

o If the autosampler is set up to recognize the installed syringe size, an error
message appears when you download methods that specify a different syringe size.

* If the autosampler is not set up to recognize the installed syringe and the specified
syringe size does not match the actual syringe size, the autosampler does not
inject the specified injection volume.

Under Recommended Injection Volume, in the Volume (uL) box, type the volume of
sample that you want the autosampler to inject.

The allowable injection volume range is based on the syringe size.

IMPORTANT For partial loop injections (variable volume), make sure that the

recommended injection volume is less than half the sample loop size.

. Under Look Ahead Injections, if the Delay Time (mins) box is available, type the amount

of time that you want the autosampler to wait after it completes the current injection
before it starts the next injection.

During a look ahead injection, the autosampler aspirates the sample for the next injection
and waits until the end of the current run to inject the sample into the valve. When you
add a delay time, the autosampler does not begin the next injection cycle immediately
after completing the current injection cycle. If you enter a delay time longer than the
method run time, the autosampler begins the next injection at the end of the current run.
This means that adding a long delay time does not add additional run time to the method
run time, but it does cancel the effect of using the Look Ahead Injections feature.

Note The Look Ahead Injections feature is available if you selected the Enable check
box in the Look Ahead Injections area of the Pal Configuration dialog box.

Specify the acquisition parameters for the other devices of the LC or LC/MS instrument.
Save the method:
a. From the Instrument Setup window, choose File > Save As.

b. Select a folder in which to store the method, and then type a name for the method in
the File Name box.

c. Click Save.
The File Summary Information dialog box appears.
d. (Optional) In the Comment box, type additional information about the method.

e. Click OK.

The Xcalibur data system (or other Thermo Scientific data acquisition applications
such as LCquan™) stores the method as a METH file in the specified file location.
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Instrument Setup Parameters

Thermo PAL User Guide

Use the Method Setup page (Figure 19 on page 28) to specify instrument method parameters

for the autosampler.

Table 7. Method Setup page parameters (Sheet 1 of 2)

Parameter

Template Selection

Description

Template

Shows the list of default method templates.

After you select a template, the Template list changes to a box
that shows the path to the selected method template file.

Method Folder

Shows the path to the default template folder before you select
a default method template.

After you select a method template (in the Template list), the
Method Folder box disappears.

Browse

Opens the Browse for Folder dialog box to locate the directory
that contains the method templates.

After you select a method template (in the Template list), the
Browse button changes to the New Template button.

New Template

Select this button to bring back the Template list, Method

Folder box, and Browse button.

After you select a method template (in the Template list), this
button appears.

Template Description

Template Description

Shows a description of the selected template, which appears in

the Template box.

Syringe

Syringe

Shows a list of the allowed syringe volumes.

Select the appropriate syringe volume.

Macro Sequence

Macro Sequence

Shows the sequence of macros that make up the method

displayed in the Template box.

Select a macro name to be displayed in the Macro area; its
variables also appear in the Variables area.
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Table 7. Method Setup page parameters (Sheet 2 of 2)

Parameter

Description

Recommended Injection Volume

Volume (pL)

When you select an instrument method for use to generate a
new sequence (on the Xcalibur Home Page), the injection
volume is set to what is entered in this box.

For the LCquan application: When “From AS” (From Auto
Sampler) is specified in the LCquan injection volume
sequence cell, the autosampler uses the volume in this box
when you submit the LCquan sequence for acquisition.

Look Ahead Injections

Delay Time (mins)

Enter the Delay Time (in minutes) between injections when

using the Look Ahead feature.

You enable the Look Ahead Injections option from the

Pal Configuration dialog box (Figure 15 on page 19). When
you enable this option, the next Look Ahead Injection is
delayed the amount of time entered in this box. The delay
time countdown begins at the completion of any
post-injection steps, which prevents a sample from being held
in the injection syringe for the duration of the current run. If
the entered Delay Time is too long, or the current run ends
prematurely, the entered Delay Time is canceled and the next
injection commences in the normal manner.

Macro

Shows the name of the selected macro, and the sequence
number (x) and total number of macros (y) (displayed as
“name”, x of y).

This area also lists the variables associated with the macro
chosen in the Macro Sequence pane.

Variables

Shows the variable parameters used by the selected macro.

* Variables with specific allowed values (discrete variables)
appear in lists. You may choose the allowed values of the
discrete variables from those presented in the list.

* Continuous variables are displayed in boxes. The allowed
values for continuous variables appear when you hold the
cursor over the variable’s box. You can type the value for
the continuous variable in the box.

Default All

This button changes the variables, used in the selected Macro
Sequence, to their default values.
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Viewing the Method Summary

Use the Method Summary page to view the details of the Macro Sequence that makes up an
autosampler Method or Template.

The contents of the Method Summary/Template Summary page is read-only.

< To view a summary of the autosampler portion of an instrument method

1. Open the Instrument Setup view for the autosampler (see “Specifying the Instcrument
Method Parameters” on page 25).

2. Choose File > Open, and then select the instrument method.

3. Click the Method Summary tab.

The Method Summary page appears with a summary of the autosampler parameters for
the active instrument method (Figure 20).
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Figure 20. Method Summary page in the Instrument Setup window
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Creating Custom Templates and Macros

This chapter describes how to create custom templates and macros. It also includes
instructions on how to define variables for macro creation. The Thermo PAL autosampler
provides three standard templates.

Contents

* Using the Template Editor to Create Custom Templates
* Testing a Custom Template

* Viewing the Template Summary

* Standard Macros

* Using the Macro Editor to Create Custom Macros

* Defining Variables

Using the Template Editor to Create Custom Templates

Use the Template Editor page of the Pal Template\Macro Editor window to make a new
template (a sequence of macros). Each macro in the sequence is made up of variables that you
may also edit on this page.

Table 8 on page 37 lists the parameters for the Template Editor page.
< To create a custom template

1. Open the Template Editor page as follows (Figure 21):

a.  Open the Instrument Setup window for the autosampler (see “Specifying the
Instrument Method Parameters” on page 25).

b. Choose Pal Auto Sampler > Template\Macro Editor.
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Figure 21. Template Editor page on the Pal Template\Macro Editor window

Template Editor | Macro Editor | Template Summary |

Template Description Macro

Default New Method P | |
Wariables

Syringe

Macro Sequence
LC-nj

Help

Save Ternplate| Save As...

. (Optional) In the Template Description box, type a description of your custom template.
. In the Syringe list, select the appropriate syringe size to be specified in the template.

. Add macros to the template as follows:

a. Under Macro, select a macro from the list.

The Insert Above and Insert Below buttons become available.

b. Click Insert Above or Insert Below.

The selected macro appears in the Macro Sequence box.

. Delete macros from the Macro Sequence box by selecting the macro and clicking Delete.

. Replace a macro in the Macro Sequence box as follows:

a. Under Macro, select a macro from the list.
b. Select the macro that you want to replace in the Macro Sequence box.

c. Click Replace.

. Save the template:

a. Click Save As.
b. Select a file location, and then type an appropriate name in the File Name box.

c. Click Save.

The autosampler saves the template with the .pma file extension.
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Table 8. Template Editor page parameters (Sheet 1 of 2)

Parameter

Template Description

Description

Enter the method description in this box.

Syringe

Select the syringe volume from this list.

Macro Sequence

Macro Sequence

Shows the macros selected for the method being made in the
Method Template Editor.

The macros in this sequence are selected from the Macro list.
Double-clicking a macro under Macro Sequence displays it in
the Macro list as described later in this table, along with the
variables that make up the macro (in the Variables area).

Insert Above

Inserts a macro from the Macro list above the macro selected
under Macro Sequence.

Insert Below

Inserts a macro from the Macro list below the macro selected
under Macro Sequence.

Replace Replaces the macro selected under Macro Sequence with the
macro that is in the Macro list.

Delete Deletes the macro selected under Macro Sequence.

Run Automatically executes the macros that constitute the Method
(Macro Sequence).

Step Executes the Method (Macro Sequence) in a stepwise manner.

Macro

Macro Select individual PAL macros in this list.
When you select a macro, it is highlighted in blue. The
sequence number (x) of the selected macro and the total
number of macros () in the Macro Sequence box (“Macro
x of y”) appear at the top of the Macro list. You can place the
selected macro under Macro Sequence by using the
Insert Above, Insert Below, or Replace buttons as appropriate.

Default All Changes all of the Method Template Editor variables to their

default values.
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Table 8. Template Editor page parameters (Sheet 2 of 2)
Parameter Description

Variables Shows the variables that make up the macro in the Macro list.

* Variables with specific allowed values (discrete variables)
appear in lists. You may select the allowed values of the
discrete variables from those presented in the list.

* Continuous variables are displayed in boxes. The allowed
values for continuous variables appear when you hold the
cursor over the variable’s box. You can type the value for
the continuous variable in the box.

Buttons

Save Template Saves the Method Template under the current file name
(overwrites the current file).

Save As Saves the Method Template under a new file name or in a new

location that you type in the Save As dialog box.

Testing a Custom Template

This section provides information about testing a custom template. Use the Run Auto
Sampler Method dialog box to enter the Methods information required for the autosampler to
carry out autosampling. Table 9 on page 40 lists the parameters for the Run Auto Sampler

Method dialog box.

< To test your new template step-by-step
1. Open the Template Editor dialog box (see “To create a custom template” on page 35).
2. Open the template to review by choosing File > Open Method Template.
The default path to open a template is as follows:

drive\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Methods
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3. Under Macro Sequence, click Step to open the Run Auto Sampler Method in Step Mode
dialog box (Figure 22).

Figure 22. Run Auto Sampler Method In Step Mode dialog box

Run Auto Sampler Method In Step Mode @

Wial Index Injectors

1 1 |LC vk -
2 2 LT Wk -
Trays Yolume
1 |CStk1-on - 1 |10
2 |Cstk1-m - 2 o

|njections Per Yial
|1

Bun LCancel Help

4. Make the appropriate entries and selections as follows:
* Under Vial Index, type an appropriate vial location for the template you are testing.
* Under Trays, select the appropriate trays.

* In the Injection Per Vial box, type the number of injections that you want to make
from each vial.

* Under Volume, type the volume that you want to inject.
5. Click Run.

The autosampler performs the actions specified in the template, step-by-step. At the

completion of each step, the autosampler pauses the injection sequence and prompts you
with the Pal Method Editor dialog box (Figure 23).

Figure 23. Pal Method Editor dialog box

Pal Methad Editor (25

Current Macro iz SL Entry
Current Cornmand is SET_QUT_SIGICCRuning, 1.
0.

Step | Run Stop Run

6. Do one of the following:

* To continue stepping through the template, click Step.
* To run the remaining portion of the template, click Run.

* To stop the run, click Stop Run.
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< To run the complete sequence of macros in the template without pausing

1. Open the Template Editor dialog box (see “To create a custom template” on page 35).

2. Open the custom template by choosing File > Template > Open Method Template.

3. Under Macro Sequence, click Run to open the Run Auto Sampler Method dialog box

(Figure 24).

Figure 24. Run Auto Sampler Method dialog box

Wial Index
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4. Make the appropriate entries and selections.

5. Click Run.

The autosampler executes the macros listed in the template.

Table 9. Run Auto Sampler Method dialog box parameters (Sheet 1 of 2)

Parameter Description

Vial Index

1 Type the vial index to be used with the method (SL.index).

2 Type the vial index to be used with the method (SL.index2).

Trays

1 Select the tray to be used with the method (SL.tray).

2 Select the second tray to be used with the method (SL.tray2).

Injectors

1 Select the injector to be used with the method (SL.injector).

2 Select the second injector to be used with the method
(SL.injector2).

Volume

1 Type the injection volume to be used with the method

(SL.volume).
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Table 9. Run Auto Sampler Method dialog box parameters (Sheet 2 of 2)

Parameter Description

2

Type the second injection volume to be used with the method
(SL.volume2).

Injections Per Vial

Type the number of replicate injections to be made from each

vial.
Buttons
Run Run the selected method.
Cancel Cancel any changes and close the dialog box.

Viewing the Template Summary

Thermo Scientific

To view a summary of a template

. Open the Template Editor dialog box (see “To create a custom template” on page 35).

. Open the template that you want to review by choosing File > Open Method Template.

The default path to open a template is as follows:
drive\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Methods

Click the Template Summary tab.

The Template Summary page appears with a summary of the active template (Figure 25).
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Figure 25. Template Summary page

Template: Editor | Macro Editor  Template Summary |

Description:
Default Mew Method

Syringe: 100ul
Macro Sequence

LC-nj [Step 1 of 1]
AirWolurne [pl): 0
Fre Clean with Salvent 1: 0
Fre Clean with Salsent 2: 0
Fre Clean with Sample: 0
Filling Speed [pl/z]: 50
Filling Strakes: 1
Inject to: LC %l
Injection Speed [pl/e) 100
Pre Inject Delay [ms): 500
Foszt Inject Delag [me]; 500
Fozt Clean with Solvent 1: 1
Fost Clean with Solvent 2 1
Walve Clean with Salvent 1:1
Yalve Clean with Salvent 2: 1

M acros uged within method

Macro name: LC-Inj
COMPLETE CYCLE

RN RN RN

Duplication of PAL's lacal LC injection cycle.

Yariables: 14
AirWolurme [pl):0:0:5%R . Max Volume
Fre Clean with Sabvent 1 []:0:0,99
Pre Clean with Solvent 2 [1:0;0:99
Fre Clean with Sample []:0:0:99
Filling Speed [pl/z).5R.Fill Speed:SYFR_Min Speed.S7H.Max Speed
Filling Strakes [];1:0;99
Inject tolMJECTOR
Injection Speed [pl/s]:5%R. Inject Speed;5YR.Min Speed;5YF.Max Speed

Tray Mame, Sample Mumber and 5 ample Yolume are taken from the sample list.

»

m
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Macros are the building blocks that you use to create templates. Figure 26 shows the macros

that are provided with a standard installation. The default path to the macros is as follows:

drive\Thermo\Instruments\LC Devices\ThermoPAL\PAL\Macros

Figure 26. Standard macros

a | Add to Sample and Mix.pma
2 | Aspirate Sample.pma

| Aspirate.pma

@ | Clean Syringe.pma

a | Clean Valve.pma

& | Clear Output Signal.pma

4 | Dispense.pma

a | DLW Priming_Rev(l.pma

@ | Error Entry.pma

fa | Error Bxit.pma

a |Homepma

a |Inject.pma

& | LC-Inj DLW Fast_Rev03.pma

A | LC-Inj DLW Standard_Rev3.pma

a | LC-Inj.pma

A | Method Entry.pma

A | Method Exit.pma

A | Pulse Output Signal.pma
A | Reset.pma

A | Set Qutput Signal.pma

& | SL Entry.pma

A | SL Exit.pma

A | Switch Valve to Inject.pma
A | Switch Valve to Load.pma
A | Transfer Liquid and Mix.prma
A | Transport Vial.pma

A | Wait for Data System.pma
4 | Wait Signal.pma

A | Wait.pma

Using the Macro Editor to Create Custom Macros

Thermo Scientific

Use the Macro Editor page of the Pal Template\Macro Editor window when you want to
create custom macros. Table 10 on page 45 lists the parameters for the Macro Editor page.

< To create a custom macro

1. Open the Macro Editor page as follows (Figure 27):

a.  Open the Instrument Setup window for the autosampler (see “Specifying the

Instrument Method Parameters” on page 25).

b. Choose Pal Auto Sampler > Template\Macro Editor.

c. Click the Macro Editor tab.

Thermo PAL User Guide
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Figure 27. Macro Editor page of the Template\Macro Editor window

'Template Editor Macro Editor |Template Summaryl

Index (;1;1;9999 8

Cmrmrd s Vinh amms fdl- W0 Blim Viedoam

4 L 3
Add.. || Edi. | Deete |

—Command Sequence

Insert Above | Insert Below |

Beplace | Delete |

GET SAMPLE

— Macro —Command 1 of 1
[Aspirate ~| | | [GET_sampLE ~| Defaut Al
— — Parameters
— Macro Description SEuEE ISu:uurce LI
Fill syringe from a wvial or a wash -
station. Index |Inde:<
Sample volume, air volume, filling
speed and filing strokes are Sample Yaolume [pl) |Sam|:ule Wolume
specified as parameters. - AirWalunne [pl) I.-’-'«ir Wolurme
~ Macro Variables Fenetration [mm) |
Air Vaolume ();0;0;5YR. Max Volur .- Fill Y olume [pl] |
Filing Speed (1d/s);SYR_Fill Speed:':l . —
Filing Strokes {;1:0:99 Fill Spered [pls) |F|II|ng Speed

Fullup Delay [mz]
Eject Speed [pl/=]
Fill Strokes
MHeedle Blocking
Mdait for Tirner
Wit Time [=)

|

|

|Filling Strokes

ot |
|

|

Gets sample from either a vial, tray or wash station.

Save Macro | Save As_ . |

Help

2. Under Macro, select a macro from the list.

The description of the selected macro appears under Macro Description and a list of

macro variables appears under Macro Variables.

3. To add a variable to the macro, do the following:

a. Click Add to open the Variable Definition dialog box (Figure 28 on page 48).

b. Define the variable (see “Defining Variables” on page 48).
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4. Save the macro as follows:

Click Save As.
Select a file location, and then type an appropriate name in the File Name box.

Click Save.

The autosampler saves the macro with the .pma file extension.

Table 10. Macro Editor page parameters (Sheet 1 of 3)

Parameter Description

Macro

This list displays existing autosampler macros. Select the
macro that you want to edit.

Macro Description Displays a description of the selected macro.

Macro Variables

Displays the variables used by the selected macro.

Add

Adds a new variable to the macro variables.

For details, see “Defining Variables” on page 48. You define
the new variable in the Variable Definition dialog box that
opens when you click Add. In this dialog box, you can select
the A Numeric Value or An Object option.

* Ifyou select a numeric variable type, you see a pane for
entering the new variable name, a list for the variable
units, and panes for entering the default value for the
variable along with the lower and upper limits for the
variable.

* Ifyou select an object variable type, you see a check list of
objects that the variable might represent.

Edit

Edits an existing macro variable.

You edit a variable in the Edit Parameter dialog box that opens
when you click Edit. In this dialog box, you can select the
A Numeric Value or An Object option.

* Ifyou select a numeric variable type, you see a pane for
entering a new variable name, a list for the variable units,
and panes for entering the default value for the variable
along with the lower and upper limits for the variable.

* Ifyou select an object variable type, you see a check list of
objects that the variable might represent.

Delete

Deletes the selected Macro Variable.

Thermo Scientific
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Table 10. Macro Editor page parameters (Sheet 2 of 3)

Parameter

Command Sequence

Description

Lists the sequence of commands that make up the macro
selected in the Macro list.

When you select a command, the command parameters and
description appear in the Command area. The command
parameters appear in both boxes (continuous variables) and
lists (discrete variables).

Insert Above

The command shown in the Command list is inserted above
the command selected (highlighted in blue) under Command
Sequence.

Insert Below

The command shown in the Command list is inserted below
the command selected (highlighted in blue) under Command
Sequence.

Replace The command selected (highlighted in blue) under
Command Sequence is replaced by the command shown in
the Command list.

Delete Deletes the command selected (highlighted in blue) under
Command Sequence.

Command

Lists the individual autosampler commands. These individual
commands make up the command sequence of an
autosampler macro. Select the command by moving the
cursor over the command (no click is needed), highlighting
each command in blue. Clicking the command displays it in
this list (highlighted in blue). Simultaneously, the command
parameters appear in the Parameters area below the
Command list.

The pane below the Parameters area describes the function of
the selected command.
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Table 10. Macro Editor page parameters (Sheet 3 of 3)

Parameter

Parameters

Description

Shows the command parameters used by the selected
autosampler command.

* DParameters with specific allowed values (discrete
parameters) appear in lists. You may choose the allowed
values of the discrete parameters from those presented in
the list.

* Continuous parameters are displayed in boxes. The
allowed values for continuous parameters appear when
you hold the cursor over the respective boxes for the
parameter. You can type the value for the continuous
parameter in its boxes and view other allowed continuous
parameter values in a shortcut menu. To activate this
menu, right-click the continuous parameter box of
interest. The parameter you select from the shortcut
menu appears in the box.

Command Description

Shows a description of the selected command in the bottom
pane.

Buttons

Save Macro

Saves the macro (command sequence) under the current file
name (overwrites the current file).

Save As

Saves the macro (command sequence) under a new file name,
in a new location, or with both a new file name and location

that you type in the Save As dialog box.
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Variables are the building blocks that you use to create macros. Use the Variable Definition
dialog box to specify the details of a numerical or object macro variable that you want to add
or edit in the Macro Variables box. Table 11 on page 49 lists the parameters for the Variable
Definition dialog box.

< To create custom variables

1. Open the Macro Editor page (“Using the Macro Editor to Create Custom Macros” on
page 43).

2. Click Add to open the Variable Definition dialog box (Figure 28).

Figure 28. Variable Definition dialog box

Variable Definition =]

Wariable Type: & & MumencValue O An Object
ak. | Cancel |

Yariable Mare: |

W ariable Units: |None j ﬁ

Drefault W alue: |IJ
Lowser Limnit: |IJ
Upper Limit: |IJ

3. Select a variable type:

* To create a variable that is a numeric value, select the A Numeric Value option, and

then go to step 4.

* To create an object variable, select the An Object option. A list of objects appears.

Go to step 5.

4. Complete the definition of a numeric variable as follows:

a.
b.
c.

d.

€.

f.

In the Variable Name box, type an appropriate name.

In the Variable Units list, select a unit of measure.

In the Default Value box, type a default value for the variable.
In the Lower Limit box, type a lower limit for the variable.

In the Upper Limit box, type an upper limit for the variable.

Click OK to save the variable and close the Variable Definition dialog box.

5. Complete the definition of an object variable as follows:

a.
b.

C.

In the Variable Name box, type an appropriate name.
Select the appropriate objects from the list (Figure 29).

Click OK to save the variable and close the Variable Definition dialog box.
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Figure 29. Object variable selections

Wariable Definition

Wariable Type: & MumencYalue & An Object

=3

Yariable Mare: |

[ SYRINGE
™ TRaY

[ AGITATOR
[~ PATH

[~ OUT_EVENT
[ MOTOR_X
[ USER

Fleaze check what objects thiz variable may be:

[ wilaL [ TR&Y_TYPE [~ TRAY_HOLDER
[ WASH_STATION [ IMJECTOR [ WALWE

[ MOTOR_DRIVE [ HEATER [ POSITION

[ SYMC_SIGNAL [ OUT_SIGMAL [ IN_EWENT

[ SWwW_EVENT [ PWR_EWVENT [ RS232

[ MOTOR_Y [ MOTOR_Z [ CHKMOTOR

ak. | Cancel |
Help

Table 11. Variable Definition dialog box parameters (Sheet 1 of 2)

Parameter

Variable Type

Description

A Numeric Value

Select this option if the parameter is a numeric value.

If you are editing an existing numerical parameter, this option
is preselected.

An Object

Select this option if the parameter is an object.

If you are editing an existing object parameter, this option is
preselected.

Variable Name

If you are editing an existing variable, this box shows the
name of the variable. If you are adding a variable, type its
name.

OK

Accepts the new Variable Definition or accepts the edits to an
existing Variable Definition.

Cancel

Deletes changes made in the Variable Definition dialog box.

Variable Type—Numeric

Variable Units

If you are editing an existing variable, this list shows the units
for the selected variable. If you are adding a variable, you may
enter units appropriate for that variable. When you click the
list arrow, you can select the appropriate units from the
options in the list.

Default Value

The nominal or center value of the variable.

Lower Limit

The lowest acceptable value of the variable.

Upper Limit

The highest acceptable value of the variable.
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Table 11. Variable Definition dialog box parameters (Sheet 2 of 2)

Parameter Description

Variable Type—Object

Please Check What Objects  Select the check boxes for one or more objects that the
This Variable May Be variable describes.
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Using the Direct Controls to Operate the
Autosampler

This chapter describes how to operate the Thermo PAL autosampler from the Direct Control
dialog box that you access from the Xcalibur Instrument Setup window or from the Inlet
Direct Control dialog box that you access from the mass spectrometer Tune application. Use
the direct controls when you want to control the autosampler before starting a run
acquisition.

Contents
* Opening the Direct Control Dialog Box
* Making Single Injections from the Tune Window
* Changing the Tray Configuration
* Specifying the Location of the Direct Control Methods

* Wrapping Direct Control Injections with Additional Macros

Opening the Direct Control Dialog Box

The direct control pages for the autosampler are available from the Instrument Setup window
and the Tune window.

< To open the Direct Control dialog box from the Instrument Setup window
1. In the Xcalibur Instrument Setup window, click the autosampler icon.

2. Choose Pal Auto Sampler > Direct Control to open the Direct Control dialog box
(Figure 30).
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Figure 30. Direct Control dialog box

Direct Control @
Methods | Tray Configuration ] Direct Control Configuration I
Method Vial Indesc
I - | |
Description 2
b Trays
1 | Tray01
2 [ Trayli
Volume
1 |10
2 1o
Injectors
1 |LC Wiwl
|2 |Lcwivi
Syringe Injections Per Vial
[
Device Status
Not Connected | Help |

% To open the Inlet Direct Control dialog box from the Tune window
1. In the Tune window, choose Setup > Inlet Direct Control.
2. Click the Thermo Pal tab to open the Inlet Direct Control dialog box.

The Inlet Direct Control dialog box has the same functionality as the Direct Control
dialog box shown in Figure 30.

Making Single Injections from the Tune Window

52
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You can make single injections from the Tune window by using the Methods page of the Inlet
Direct Control dialog box. Table 12 lists the parameters for the Methods page of the Inlet
Direct Control dialog box.

< To make single injections from the Tune window
1. Open the Tune window for your mass spectrometer.

2. Open the Inlet Direct Control dialog box (see “Opening the Direct Control Dialog Box”
on page 51).

3. Specify the location of the methods that you want to use by using the Direct Control
Configuration page (see “Specifying the Location of the Direct Control Methods” on
page 56).
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. Specify the tray types that are loaded in the autosampler tray holders (see “Changing the
Tray Configuration” on page 54).

. Click the Methods tab.

The Methods page appears. The Syringe area lists the size of the configured syringe. The

Device Status area provides the status of the autosampler.
. In the Method list, select a method.

A description of the method appears in the Description box. The method list depends on
the file locations specified on the Direct Control Configuration page.

Note The visible DLW methods in the Method list are only available if you installed
the DLW option that comes with the autosampler. See Chapter 5, “Using Dynamic
Load and Wash (DLW).”

. Make the following selections and entries:

* Under Vial Index, type the location of the sample vial.

* Under Trays, select the tray where the sample vial is located.

* Under Volume, type the volume that you want the autosampler to inject.

. In the Inlet Direct Control dialog box, click the tab for the configured LC pump and start
the solvent flow from the LC pump.

Note The Thermo PAL autosampler only downloads the method parameters for the
autosampler. It ignores the method parameters for the LC pump and the mass
spectrometer.

9. Return to the autosampler Methods page, and then click Run.

Table 12. Methods page parameters (Sheet 1 of 2)

Parameter
Method

Description

Use this list to select a method file. The visible DLW
methods in the Method list are only available if you
installed the DLW option that comes with the
autosampler.

Description

Contains a description of the selected method.

Syringe

Lists the size of the configured syringe.

Device Status

Displays the status of the autosampler.

Thermo Scientific
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Table 12. Methods page parameters (Sheet 2 of 2)

Parameter Description

Vial Index

1 Type the vial index to be used with the method
(SL.index).

2 Type the second vial index to be used with the method
(SL.index2).

Trays

1 Select the tray to be used with the method (SL.tray).

2 Select the second tray to be used with the method
(SL.tray2).

Volume

1 Type the injection volume to be used with the method
(SL.volume).

2 Type the second injection volume to be used with the
method (SL.volume2).

Injectors

1 Select the injector to be used with the method
(SL.injector).

2 Select the second injector to be used with the method

(SL.injector2).

Injections Per Vial

Type the number of replicate injections to be made
from each vial.

Run

Runs the selected method.

Changing the Tray Configuration

Use the Tray Configuration page of the Direct Control dialog box to specify the tray types to
be used for direct control injections. The autosampler uses this tray information instead of the

tray information specified in the autosampler Control Terminal.

Table 13 lists the parameters for the Tray Configuration page of the Direct Control

dialog box. For information about the sample trays, see Appendix A, “Sample Trays.”

IMPORTANT The autosampler does not store the tray configuration that you specify on
the Tray Configuration page of the Direct Control dialog box. When you close the dialog

box, the tray configuration resets to the autosampler Control Terminal settings.
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Changing the Tray Configuration

< To temporarily change the tray configuration

1. Open the Direct Control dialog box (see “Opening the Direct Control Dialog Box” on

page 51).

2. Click the Tray Configuration tab to open the Tray Configuration page (Figure 31).

For information about the sample trays, see Appendix A, “Sample Trays.”

Figure 31. Tray Configuration page (V154 example)

Direct Control

Methods Tray Configuration | Direct Control Configuration |

Tray Holder: Stack1

X3

DOO0OONO0
1011 12113114115(16)17,18
(19)20/212223)24)25)2627)
(28)29/3013132)33/(34)35,36
(37)38)39140(41)(42)43)44 /45
(46)47)48/4915051/52)53/54

Vials In X Direction: 9

Vials In Y Direction: 6 Help

3. In the Tray list, select the tray that you want to modify.

4. In the Type list, select the tray type.

Table 13. Tray Configuration page parameters (Sheet 1 of 2)

Parameter Description

Tray Select the tray location in the three-drawer (deep
drawer) configuration. For information about the
sample trays, see Appendix A, “Sample Trays.”
Range: Tray01-Tray12

Type Select the tray type.

Thermo PAL User Guide
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Table 13. Tray Configuration page parameters (Sheet 2 of 2)
Parameter Description
Tray Holder The allowed values are as follows:
* Stackl, for Tray01-Tra06
* CStackl, for Tray07—Tray12

Tray holders can hold one or more trays. A Stack is a
tray holder that is designed to hold micro plates. The
autosampler firmware determines the type and
number.

Vials in X Direction, Determined by choice of tray type.
Vials in Y Direction

Specifying the Location of the Direct Control Methods

Use the Direct Control Configuration page of the Direct Control dialog box to specify the
location of the methods that you can open on the Methods page. Table 14 lists the parameters
for the Direct Control Configuration page.

< To specify the method folders

1. Open the Direct Control dialog box (see “Opening the Direct Control Dialog Box™ on
page 51).

2. Click the Direct Control Configuration tab to open the Direct Control Configuration
page (Figure 32).

The default path to the methods that appear in the Method list on the Method page is as

follows:

drive\Thermo\Instruments\LC Devices\ThermoPAL\PAL\DirectControlMethods
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Figure 32. Direct Control Configuration page of the Direct Control dialog box

Direct Control @
Methods | Tray Configuration  Direct Conttrol Configuration |
Wrap each direct control method run with the following macros:
v Sequence Entry Exit v Method Entry Exit
Method Search Paths
Path: | Default folder (directory) for
Browse... | Add Resef. the direct control methods

Firmware Version
<Unknownz:

C:A\Themenstrumentsi\LC Devices\ ThermoP ALNPALDirectCortrol I

Help

3. To add additional file locations, type the folder location in the Path box or click Browse
to find the appropriate folder, and then click Add.

The new folder location appears in the box below the row of buttons.

4. To delete a file location, select the folder path, and then click Delete.

5. To reset the file location to the default folder, click Reset.

Table 14. Direct Control Configuration page parameters (Sheet 1 of 2)

Parameter

Description

Wrap Each Direct Control Method Run with the Following Macros

Sequence Entry Exit

Select this check box to wrap methods with the
sequence list entry and exit macros (SLentry and
SLexit).

Method Entry Exit

Select this check box to wrap methods with the

method entry and exit macros (Method Entry and
Method Exit).

Note For more information, see Wrapping Direct Control Injections with Additional

Macros.
Method Search Paths
Path Type the extra path that you want to add for the
method search routine.
Browse Use this button to search for the path to a file folder.
Add Use this button to add a file folder for the method

search routine.
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Table 14. Direct Control Configuration page parameters (Sheet 2 of 2)

Parameter Description

Delete Use this button to delete a file folder from the method
search routine.

Reset Use this button to remove all of the user-added file
folders.

[text box] Displays the file folders (directories) where the
autosampler searches for methods.

Firmware Version Specifies the firmware version downloaded from the
autosampler.

Wrapping Direct Control Injections with Additional Macros
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Use the Direct Control Configuration page of the Direct Control dialog box to specify
whether the autosampler is to run the SL Entry and SL Exit, the Method Entry and Method
Exit, or all of these macros before and after an injection.

< To specify the use of the SL Entry and SL Exit macros

Select the Sequence Entry Exit check box.

< To specify the use of the Method Entry and Method Exit macros
Select the Method Entry Exit check box.
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Using Dynamic Load and Wash (DLW)

This chapter describes how to use the Dynamic Load and Wash (DLW) option, which
includes how to install the Cycle Composer Macros or ICC Cycles, how to operate the DLW,
and a step-by-step illustration of the DLW cycles.

Contents

* Overview

* Installing Cycle Composer Macros or ICC Cycles
* Operating Dynamic Load and Wash (DLW)

* DLW Cycle Step-by-Step

Overview
This section contains an overview of the Dynamic Load and Wash (DLW) option.

The DLW option (Figure 33) represents a new wash station concept that combines an
injection cycle with wash steps. The linked combination of the two steps, which are usually
separate, minimizes cycle time and carryover.

There are two characterizing features for the DLW option:
* The sample solution never contacts the syringe itself; it is held between the holding loop.

* Wash solvents are pumped from back to front into the DLW system to intensely flush all
critical parts that are in contact with the sample.
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Figure 33. Dynamic Load and Wash (DLW)

—

The DLW option consists of two self-priming micro pumps (mounted on a dedicated
bracket), and the wetted parts are Ryton™ PPS and Kalrez™ (FFPM). The pump IN ports
connect to the wash solvent bottles and the OUT ports connect to the DIW manifold, which
is part of the assembly of the dedicated DLW syringe holder. A holding loop separates the
syringe from the DLW actuator to prevent sample from contacting these parts.

The syringe and holding loop are preloaded with wash solvent #1 at the start. The sample is
picked up and remains separated from wash solvent #1 by an air gap. After loading the loop
and injection, wash solvent #1 is pushed into the system, followed directly by wash solvent #2
to flush the critical valve paths.

The DLW syringe assembly moves to the wash station for further cleaning steps and for
preparing the syringe and holding loop for the next cycle.

For further details, see “DIW Cycle Step-by-Step” on page 72.
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Installing Cycle Composer Macros or ICC Cycles

You can only operate the autosampler DLW option with PAL control software, such as the
ThermoPAL driver for the Xcalibur data system or Cycle Editor for ICC interpretation in
another data handling system software.

For software control, the autosampler provides three macros or three cycles:
* Priming Accela Open

For initial and daily routine priming of the solvent lines and DLW manifold. The Clean
Time for both wash solvents is a variable for the user to define the intensity of washing.

* Standard Injection Accela Open

Standard injection cycle using all possibilities of the DLW option. The injection valve
inlet port and the needle are washed with both wash solvents (inside and out). You can
add an extra Stator Wash for intensive washing of the injection valve (valve toggle).

* Fast Injection Accela Open

Tuned for speed and high-throughput application. It differs from the Standard DLW

macro in that some steps are left out to shorten the cycle time.

For detailed descriptions of all macros (or cycles), see Table 15 on page 63 and Table 16 on
page 64.

Note The provided macros are written for standard injection valve drives, which are
controlled and activated through the AUX interface.

Installing the Cycle Composer Macros or ICC Cycles

The autosampler ships with a DVD containing various cycles for the DLW option. Macros
for the Xcalibur data system are installed by the LC Devices installer. Copy these macros to
your ThermoPAL driver method folder or the corresponding folder for application within the
integrated system.
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< To copy cycles to your Cycle Composer

1. Navigate in Windows Explorer to the ThermoPAL driver folder. The usual folder location
is as follows:

drive\Thermo\Instruments\LC Devices\ThermoPAL\PAL\

2. If you want to add the DLW option macros to an existing method folder, copy the macro
(.pma) and the method (.pme) files from the DLW Option folder on the DVD to the
method folder.

If the PAL system is integrated in a data system software that controls the autosampler by
using the Cycle Editor for PAL ICC interpretation (for example, Analyst™,
ChemStation™, Empower™, EZChrom, MassLynx™, or Xcalibur), an ICC Cycle is used
and not the Cycle Composer Macro. The cycle file extension is .cyx.

Tip You can convert a Cycle Composer macro to a cycle (extension .cyx) by using the
Cycle Editor software. Conversion is available starting with Cycle Editor version 1.4.0.4.

General Considerations

You must establish the duration of the wash steps for each configuration and application.
Consider factors such as the viscosity and surface tension of the individual wash solvent
composition and the backpressure of the system.

Be aware that a higher backpressure builds up if the valve bore size (standard valve bore

0.25 mm) or the installed loop internal diameter is lower. Standard loop internal diameter
(ID) for Thermo-defined loops with a volume of 5, 10, and 20 pL is 0.25 mm. The loop with
2 pL content volume has an ID of 0.125 mm.

Keep the tubing internal diameters of the tubing in line with the valve dimensions, loop ID,
and flow rate.

Priming the Solvent Lines, Wash1 and Wash2

62

Use this macro at installation to prime the entire system.

< To prime the solvent lines
1. Set the wash time to approximately 120 seconds for each solvent.

2. After installation, for best results prime the system before activating the first run. For
daily preparation of the system, the wash time can be much shorter: approximately
20 seconds. The goal is an entire liquid system free of any air bubbles.

Table 15 lists the Priming Accela Open AS_Rev01 macro parameters.
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Table 15. Priming Accela Open AS_Rev01 macro (Sheet 1 of 2)

Macro description

The injection unit moves to the DLW Wash
Station, position Wash1.

Macro variable

Clean Time solvent 1

Eject Speed DLW Syringe

The injection unit moves to the DLW Wash
Station, position Wash?2.

Clean Time solvent 1
Eject Speed DLW Syringe

The DLW system is rinsed with Wash
Solvent 1 in position Waste.

The injection valve is cleaned first with the
content of the DLW syringe (Wash

Solvent 1), followed by Wash Solvent 2 and
finally, the last wash to prepare the system
for an injection cycle, rinsed with Wash
Solvent 1 again.

Remark: The Atom Rinse Inj is new,
available starting with FW 4.1.x. The DLW
actuator/solenoid is activated; the Wash
Solvent (pump), the Needle Gap, and the

Rinse Time are selectable.

Needle Gap is a parameter from Rinse Inj
Atom. The variable in this macro is Needle

Gap Valve Clean.

The function of this parameter is to
minimally raise the needle in the injection
port to allow rinsing around the needle tip.

The pressure of the spring-loaded balls in the
DLW Syringe Holder assembly is released by
moving approximately 3 mm up (default).
This leaves a gap, between the needle tip and
the valve bottom, of approximately 1 mm to
enable a flush at this contact point.

A Repeat-End loop enables adding an extra
rinsing step, valve toggle.

Stator Wash:
Counter 0 = disable valve toggle steps
Counter 1 = enable valve toggle steps

If the counter is set to 1, follow the described
steps below. If the counter is set to 0, the
macro finishes at this point.

The injection moves to the injection valve.
The valve is switched to the Active position.

The valve is rinsed with Wash Solvent 2,
followed by Wash Solvent 1.

Stator Wash Time Solvent 2
Stator Wash Time Solvent 1

Remark: The loop is filled with the last rinse
of Wash Solvent 1. Verify the composition of
Wash Solvent 1. The solvent should have a
lower elution power than the solvent
gradient starting conditions or sample
solvent composition. This is important for
partial loop filling.
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Table 15. Priming Accela Open AS_Rev01 macro (Sheet 2 of 2)

Macro description

The injection valve is switched back to the
Standby position.

Macro variable

End of macro DLW Priming.

Standard DLW Injection Cycle
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Table 16 lists the Stand Injection Accela Open macro parameters.

Table 16. Stand Injection Accela Open macro parameters (Sheet 1 of 3)

Macro description

The PAL system waits first for the Sync

Signal Ready before the injection cycle starts.

Macro variable

Remark:
Sync Signal setting Start

The injection valve moves to a defined Inject to
Standby position. Standby

The Rear air segment pulls into the Holding  Airgap Volume
Loop. Filling Speed

The sum of Rear-, Sample List-, and
Front-Volume aspirates into the Holding

Front Volume
Rear Volume

Loop. (SL.volume)

The Front air segment aspirates. Airgap Volume
Filling Speed
Pullup Delay

The injection unit moves to the DLW Wash

Station, Wash1 position.

The needle is inserted (dipped) for 1 second

to wash the outer needle surface. No plunger

movement at this step.

The injection unit moves to the specified Inject to

injection valve.

The Front- and Airgap-Volume is ejected.

Front Volume
Airgap Volume
Injection Speed

The PAL system waits for the data system. Whait for DS
The injection valve switches to Active Inject to
position. Pre Inject Delay
Wait the Pre Inject Delay time.

The loop fills with the sample volume as (SL.volume)

specified in the Sample list.

Injection Speed
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Table 16. Stand Injection Accela Open macro parameters (Sheet 2 of 3)

Macro description

The injection valve switches to Standby
position, the loop content is injected.

Timer Delay Stator Wash starts and sends a
Start signal to the HPLC system.

Macro variable

Post Inject Delay

Timer 1

The plunger of the DLW Syringe moves
down to dispense the Rear Sample and Air
Segment to Waste. The Holding Loop is still
filled with Wash Solvent 1.

(Syr. Eject Speed)

The DLW Actuator/Solenoid activates to
deliver Wash Solvent 2 into the Holding
Loop to clean the injection valve from Port 1
to Port 2.

For this step the needle tip is lifted, releasing
the sealing pressure to enable rinsing around
the tip sealing point.

Wash2

Inject to

Needle Gap Valve Clean
Valve Clean Time Solvent 2

The injection unit moves to the DLW Wash
Station, Wash2 position.

The needle is rinsed inside and out with
Wash Solvent 2.

Wash2
(Syr.Eject Speed)

Post Clean Time Solvent2

The injection unit moves back to the

injection valve. The Inlet Port and engraving
to waste Port are flushed with Wash Solvent
1 to prepare the valve for the next injection.

Wash1

Inject to

Needle Gap Valve Clean
Valve Clean Time Solvent 1

The injection unit moves back to the DLW
Wash Station, Wash1 position to flush the
syringe needle inside and out with Wash
Solvent 1.

This is a preparation step for the next
injection, and especially important for
biofluid samples.

Wash1
Post Clean Time Solvent 1

Cycle end for LC-Inj DLW Standard macro.

An optional cleaning step is attached to the
DLW Standard injection cycle: Stator Wash

or valve toggle.

A Repeat-End loop can be activated with the
Count.

Stator Wash
Stator Wash count: 1 = Cleaning step active
Stator Wash count: 0 = Cleaning step

disabled
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Table 16. Stand Injection Accela Open macro parameters (Sheet 3 of 3)

Macro description Macro variable

If Stator Wash is activated, the following
steps are executed.

The injection unit moves to the injection Inject to
valve. From the last step above, the Holding Delay Stator Wash
Loop is filled with Wash Solvent 1. (Active)

Timer 1 waits to switch the valve (Toggle)
into Active position (fill loop).

The DLW Actuator/Solenoid activates to Inject to
deliver Wash Solvent 2 to the Holding Loop  Wash2
and into the valve system. Stator Wash Time Solvent 2

The first solvent flush arriving at the valve is
Wash Solvent 1 parked in the Holding Loop
at the beginning, followed by Wash

Solvent 2.
Wash Solvent changes to Wash Solvent 1. Inject to
Washl
Stator Wash Time Solvent 1
The injection valve switches back to the Inject to
Standby position. (Standby)

Fast DLW Injection Cycle

The Fast injection cycle differs from the Standard cycle as follows:

* The needle is not dipped in the Wash station Wash]1 after sample pickup and before it

moves to the injection valve.

* The wash steps after injection are reduced to Valve Clean with Wash Solvent 1 and Wash
Solvent 2. The DLW needle is flushed in the DLW Wash Station with Wash Solvent 1
only.

* Stator Wash (valve toggle) is not available.

Table 17 lists the Fast Injection Accela Open macro parameters.
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Table 17. Macro Fast Injection Accela Open (Sheet 1 of 2)

Macro description

The PAL system waits first for the Sync

Signal Ready before the injection cycle starts.

Macro variable

Remark:
Sync Signal setting Start

The injection valve moves to a defined Inject to
position: Standby. Standby

The Rear air segment aspirates into the Airgap Volume
Holding Loop. Filling Speed

The sum of Rear-, Sample List-, and
Front-Volume aspirates into the

Front Volume
Rear Volume

Holding Loop. (SL.volume)
Airgap Volume
The Front air segment aspirates. Filling Speed
Pullup Delay
The injection unit moves to the specified Inject to

injection valve.

Front Volume

The Front- and Airgap-Volume ejects to Airgap Volume
Waste. Injection Speed
The PAL system waits for the data system.  Wait for DS
The injection valve switches to Active Inject to

position.
Wait the Pre Inject Delay time.

The loop fills with the sample volume as
specified in the sample list.

The injection valve switches to Standby
position, and the loop content is injected.

Pre Injection Delay

(SL.volume)

Injection Speed
Post Inject Delay

The plunger of the DLW Syringe moves
down to dispense the Rear Sample and Air

Segment to Waste. The Holding Loop is still

filled with Wash Solvent 1.

Injection Speed

The DLW Actuator/Solenoid activates to Inject to
deliver Wash Solvent 2 into the Holding Wash2
Loop to clean the injection valve from Port 1  Needle Gap Valve Clean

to Port 2. Valve Clean Time Solvent 2

For this step the needle tip is lifted, releasing
the sealing pressure to enable rinsing around
the tip sealing point.
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Table 17. Macro Fast Injection Accela Open (Sheet 2 of 2)

Macro description Macro variable

Wash Solvent 1 follows to prepare the valve ~ Washl

for the next injection. Inject to
Needle Gap Valve Clean
Valve Clean Time Solvent 1

The injection unit moves back to the DLW~ Washl

Wiash station, Wash1 position to flush the Post Clean Time Solvent 1
syringe needle inside and out with Wash

Solvent 1.

This is a preparation step for the next
injection, and is especially important for
biofluid samples.

Cycle ends for LC-Inj DLW Fast macro.

Operating Dynamic Load and Wash (DLW)

This section describes how to operate the Dynamic Load and Wash (DLW) option.
* Priming the Solvent Lines
e Location of Solvent and Waste Bottles

e DLW Pumps

Priming the Solvent Lines

Tip For trouble-free DLW operation, make sure the two solvent lines are free of air
bubbles at all times. If the solvent lines are being connected for the first time or during a
solvent change, you must prime the solvent lines properly until air bubbles are no longer
visible. Use solvent degassing for best results.

To make the initial and daily priming efficient and controllable, the Open autosampler comes
with a Cycle Composer macro, or ICC cycle.

< To prime the solvent lines
1. Load the macros and methods into the folder.
2. Start the corresponding macro for initial or daily priming.

3. Check the solvent lines and prime until air bubbles are no longer visible.

4. Press F4 for Home.
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Location of Solvent and Waste Bottles

DLW Pumps

The DLW option contains self-priming membrane pumps. You can place the solvent bottles
either in the fast wash station holder or on the lab bench.

You must place the Waste bottle greater than 30 cm (11.8 in.) below the injection valve. Make
sure that the waste liquid can flow into the waste bottle without restriction. Place the waste
tubing above the level of the liquid. Ideally, the tube is fixed at the neck of the waste bottle.

Tip Use good laboratory practice to avoid contaminating the wash solvents and the wash
bottles. Avoid biological growth in pure water by either replacing it regularly or adding a
small percentage of organic solvents, such as methanol or acetonitrile. Certain buffer
solutions can decompose at room temperature when exposed to light. Filtering the wash
solvents before filling the bottle, especially if using salt buffers, is mandatory to avoid any
clogging of the solvent paths.

From the control point of view, the DLW pumps respond in the same manner as the fast wash
station. Power-out signals activate the pumps. Because the electric current setting for the

DLW is different, you must load the corresponding PAL Firmware Objects for the DLW wash
station type.

The wetted parts in the pump are made from the following materials:
e Membrane: Kalrez (FFPM)

* Body, valves: Ryton PPS

The pumps are self priming with a maximum suction lift of a 3 m column of water.

DLW Actuator/Solenoid

Thermo Scientific

The DLW Actuator/Solenoid has the function of separating and completely shutting off the
lines in the direction of the syringe (sample loading) or the wash solvent lines.

After opening the DLW Actuator/Solenoid for the wash solvent lines, you can pump the
desired wash solvent into the system by activating the corresponding DLW pump.

Figure 65 on page 102 illustrates this functionality as part of the step-by-step cycle for a
standard injection.

The wetted parts in the DLW Actuator Solenoid are made from the following materials:
* Solenoid body: PEEK™
¢ Seal material: FFKM (Simriz™)
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Note PEEK exhibits excellent chemical resistance to most of the chemicals used.
However, the following solvents are not recommended for use with PEEK: DMSO, THE
methylene chloride (dichloromethane), nitric acid, or sulfuric acid. For more details, refer
to the compatibility tables provided by the manufacturer of PEEK material or
components.

Note Current applied from the actuator control PCB to the actuator/solenoid activates a
green LED. This activation does not indicate that the solenoid opens or closes.

Figure 34 shows the DLW manifold and the actuator/solenoid connections. Figure 35 shows
the DLW flow diverter being inserted.

Figure 34. DLW manifold and Actuator/Solenoid
Closed
Solvent NC

- -

DLW Flow
Diverter

Solvent 2
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Figure 35. Inserting the DLW Flow Diverter

Syringe

b 0
DLW Flow Holding Loop
Diverter
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DLW Cycle Step-by-Step

This section provides illustrations to demonstrate a step-by-step DLW cycle.

* Cycle for Standard Injection
* Additional Valve Toggle Step to DLW Standard Cycle

* Cycle for Fast Injection

Cycle for Standard Injection

Figure 36 to Figure 49 illustrate a step-by-step cycle for the standard injection.

Figure 36. Standard: Start the cycle

Solenoid /
Actuator Valve
Pump1 =>
Pump2 —>
Halding Loop

[ )
Wash 1 .

Column

Sample

Pump

72 Thermo PAL User Guide

Thermo Scientific



5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 37. Standard: Step 1 — Aspirate rear air segment

Solenoid [
Actuator Valve

Pump 1 =
[————
e
Pump2 —p» |

Holding Loop

~ Rear air segment

Column
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Figure 38. Standard: Step 2 — Get sample and aspirate rear, inject, and front volume

Solenoid /
Actuator Valve

Pump1 =
Pump2 —=>

ap

Holding Loop

Wash 2 Wash 1

Column

Sample

Pump
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Figure 39. Standard: Steps 3 - 4 — Aspirate front air segment

Solenoid /

Actuator Valve
Pump 1 —> I

e &

L= I

Pump2 =
Holding Loop
i |

Front air segment

==

Wash 1

Column
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Figure 40. Standard: Steps 5 - 6 — Insert the needle in wash position 1 to clean the outside

Pump i =

Pump2 —»
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Figure 41. Standard: Steps 7 - 8 — Dispense front air segment and front sample volume to waste

Solenoid /

Actuator Valve

Pump 1 —=> ‘g ‘ ‘
— ——— —
Pump2 —=>

Holding Loop

Front volume -

Wash 2 Wash 1
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Figure 42. Standard: Steps 9 - 10 — Switch valve to LOAD position and fill loop with inject volume

Pump1 =

Pump2 —>

Wash 2

Solenoid /
Actuator Valve
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Figure 43. Standard: Step 11— Switch valve to INJECT position and start chromatographic process

Solenoid /
Actuator Valve
Pump 1 l
4
Pump2 = l

Wash 2 Wash 1

s
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Figure 44. Standard: Step 12 — Dispense rear sample volume and air segment to waste
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Actuator Valve
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Figure 45. Standard: Steps 13 - 14 — Clean valve with Wash Solvent 2

Solenoid /
Actuator Valve

Pump1 =>
_—
- -
Pump2 =p»

Wash 1
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Figure 46. Standard: Steps 15 - 16 — Wash the syringe needle with Wash Solvent 2

Solenoid /
Actuator Valve
Pump 1 =>
-
=== = = = =
Pump2 =>
)]
Holding Loop

Wash 1

Wash 2
Column

Pump

Waste
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Figure 47. Standard: Steps 17 - 18 — Clean valve with Wash Solvent 1

Pump 1 =»

Pump2 —p

Solenoid /
Actuator Valve

Wash 1

Pump
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DLW Cycle Step-by-Step
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Figure 48. Standard: Steps 19 - 20 — Wash the syringe needle with Wash Solvent 1

Solenoid /
Actuator Valve
Pump | = |
Ee======
| ———————
Pump 2 — ’ ‘ u
Holding Loop
Wash 2 Wash 1
— Column
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Pump
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Figure 49. Standard: End cycle

Solenoid /
Actuator Valve

Pump1 =>» ‘-\_Q
_>—' ]
Pump2 —=>

Huldlng@

Additional Valve Toggle Step to DLW Standard Cycle

This section contains information about additional steps that are necessary for a DLW

Standard Cycle.
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Considerations for Additional Stator Wash Cleaning Step
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The DLW Standard Cycle has the built-in option for the user to switch the injection valve at
the end of the chromatographic run before equilibration of the column to the start
conditions.

If the method variable “Stator Wash” is set to “1,” the extra cleaning process for the valve, with
“Valve Toggle,” is part of the standard cycle.

If the method variable is deactivated (setting “0”), the DLW Standard cycle ends as shown in
Figure 49 on page 85.

The macro (cycle) is written such that the optional valve toggle steps can be executed before
re-equilibration of the column. You must synchronize the time to switch the valve with the
chromatographic method by using the method variable Delay Stator Wash. The two wash
solvents are timed by the method variables, Stator Wash Time Solvent 1 and Stator Wash
Time Solvent 2. After these wash times have elapsed, the valve switches back to the start
position.

Figure 50 illustrates the recommended retention time for Stator Wash or Valve Toggle times.

Figure 50. Timing for Stator Wash Step

Valve Toggle

% B

Absorbance

Gradient '

\
N
S~

Start

From a chromatographic viewpoint, the optional cleaning step is important to understand.
Assuming that the valve stator between ports 1 and 6 (for example, in the standard
Cheminert™ valve) is contaminated and cannot be cleaned during the injection process, the
valve toggle brings the engraving back between the two ports. Flushing the valve with both
wash solvents eliminates remaining sample material located between stator ports 1 and 6.

What points must you consider when you use the Stator Wash or Valve Toggle option?

Observe the rules if biofluid samples are injected. First, sample contact should always be with
an aqueous solution to avoid protein precipitation. After washing with organic solvent (higher
elution power), flush the system again with wash solvent 1.
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The first toggle near the end of the chromatographic cycle provides the advantage that the
sample loop is already flushed out first with the mobile phase with a solvent of high elution
power (assuming gradient application).

The second valve toggle time follows immediately after finishing the second solvent flush. You
cannot program a second switching time. The waiting time for the second valve toggle should
be long enough so that the entire system is flushed out by both wash solvents.

Consider the entire delay volume to determine the second valve switch. The DLW internal
volumes are as follows:

Manifold, 90 pL

Holding Loop,108 pL

Syringe Needle Gauge 22, 6.7 pL
Installed Injection Loop

Total delay volume: 205 pL + Loop content volume

Do the second valve toggle (back to starting condition) before the system equilibration time
has started. The Loop content is ideally a solvent of a low elution power when switched back.

If you apply isocratic chromatography, the remaining contaminants might be washed into the
system and can build up higher background noise for the column, the detector, or both over a
longer period of time.
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Additional Cleaning by Using the Stator Wash or Valve Toggle

Figure 51 to Figure 56 illustrate additional cleaning steps for “Stator Wash.”

Stator Wash: End of Standard Injection Cycle

Figure 51. Start the additional Valve Toggle cleaning step

s
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Actuator Valve
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Figure 52. Stator Wash: Step 1 - 2 — Switch valve to Load Position (toggle) and clean valve with
Wash Solvent 1
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 53. Stator Wash: Step 3 — Clean valve with Wash Solvent 2
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 54. Stator Wash: Step 4 — Wash Solvent 1 dispenses Wash Solvent 2
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 55. Stator Wash: Step 5 — Wash Solvent 1 cleans second valve
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 56. Stator Wash: Step 6 — Switch valve back to Inject Position (toggle)
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Cycle for Fast Injection

Figure 57 to Figure 68 illustrate a step-by-step cycle for the Fast Injection.

Figure 57. Fast: Cycle starts
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 58. Fast: Step 1 — Aspirate rear air segment
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 59. Fast: Step 2 — Get sample and aspirate rear, inject, and front volume
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 60. Fast: Step 3 - 4 — Aspirate front air segment
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Thermo PAL User Guide

Figure 61. Fast: Steps 5 - 6 — Dispense front air segment and front sample volume to waste
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 62. Fast: Steps 7 - 8 — Switch valve to LOAD position and fill loop with Inject Volume
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step
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Figure 63. Fast: Step 9 — Switch valve to INJECT position and start chromatographic process
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5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 64. Fast: Step 10 — Dispense rear sample volume and air segment to waste

Solenoid / @
Actuator Valve
Pumpl —> | ||
| S—

Pmpz S| |

Holding Loop

s

Wash 1

Column

Pump

Thermo PAL User Guide 101



5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 65. Fast: Steps 11 - 12 — Clean valve with Wash Solvent 2

Solenoid /
Actuator Valve

Pump1 —=>
_
Pump2 e=p

Holding Loop

p

Wash 1

Column

Pump

102 Thermo PAL User Guide Thermo Scientific



Thermo Scientific

5 Using Dynamic Load and Wash (DLW)
DLW Cycle Step-by-Step

Figure 66. Fast: Steps 13 - 14 — Clean valve with Wash Solvent 1
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5 Using Dynamic Load and Wash (DLW)

DLW Cycle Step-by-Step
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Figure 67. Fast: Step 15— Wash the syringe needle with Wash Solvent 1
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Figure 68. Fast: End cycle
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Sample Trays

This appendix describes the nomenclature for the stack number, tray location number, and
sample start location number.

Note You must use the handheld Control Terminal to specify the stack, tray location, and
sample start numbers.

For more information about the trays, refer to the Accela Open Autosampler Hardware Manual.
Contents
* Tray Types
* Tray Position

* Sample Position

Tray Types

Figure 69 through Figure 72 show the tray types for use in the Thermo PAL autosampler.
Figure 69. Tray type V54
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54-position, vial tray (9 x 6)
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A sample Trays
Tray Types

Figure 70. Tray type MT96

96-position, standard shallow micro plate (12 x 8)

Figure 71. Tray type DW96

T @ ™ m O O W >

96-position, deep well micro plate (12 x 8)
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A sample Trays
Tray Types

Figure 72. Tray type MT384
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384-position, high-density shallow micro plate
(24 x 16)
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A sample Trays
Tray Position

Tray Position

The nomenclature for the stack, tray, and sample positions is as follows:

CStk1-TT:8S

Where:

* CStkl refers to the first stack cooler, which contains multiple tray drawers. (The

designation for a second stack cooler is CStk2.)

* TTis the tray position within the overall stack. Figure 73 shows the six tray positions,
numbered 01 through 06, for a three-drawer stack.

Figure 73. Tray positions in a stack cooler with three drawers

Position 02
(back)
04
Position 01
(front)
06
03
05
Front of drawer

Top drawer

Middle drawer

Bottom drawer

* SS is the sample position within the designated tray. For examples, see Table 18 and the

formula that follows the table.
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A sample Trays
Sample Position

Sample Position

For the 54-position tray, use the marked numbers on the tray to specify the sample start
location. For the 96-position well plates, use the position numbers listed in Table 18. For the
384-position well plate, use the formula that follows the table to calculate the sample start
position number.

Table 18. Position numbers for the 96-position (12 x 8) micro plate

A-B  No. B-C  No. C-D No. E-F No. F-G No. G-H No.

Al 1 B5 17 C9 33 A 49 F5 65 G9 81
A2 2 B6 18 Clo0 34 E2 50 Fo 66 Gl10 82
A3 3 B7 19 Cll1 35 E3 51 F7 67 Gll 83
A4 4 B8 20 Cl2 36 E4 52 F8 68 Gl12 84
A5 5 B9 21 D1 37 E5 53 F9 69 H1 85
A6 6 B10 22 D2 38 E6 54 F10 70 H2 86
A7 7 B11 23 D3 39 E7 55 F11 71 H3 87
A8 8 B12 24 D4 40 E8 56 F12 72 H4 88
A9 9 Cl1 25 D5 41 E9 57 Gl 73 H5 89
Al10 10 C2 26 D6 42 E10 58 G2 74 H6 90
All 11 C3 27 D7 43 E11 59 G3 75 H7 91
Al2 12 C4 28 D8 44 E12 60 G4 76 H8 92
B1 13 C5 29 D9 45 F1 61 G5 77 H9 93
B2 14 Co6 30 D10 46 F2 62 G6 78 H10 94
B3 15 C7 31 D11 47 F3 63 G7 79 Hi1 95
B4 16 C8 32 D12 48 F4 64 G8 80 H12 96
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A sample Trays
Sample Position

Use the following formula to calculate the sample position number:
N=(Row-1] x W) + Col
Where:
* Nis the calculated sample position number in the tray.
* Row is the sample’s row converted to a number.
A equals 1, B equals 2, C equals 3, and so on.
* Wis the total number of columns on the tray:
— Equals 12 for the 96-position tray
—  Equals 24 for the 384-position tray
* Colis the sample’s column number:
— Equals 1 to 12 for the 96-position tray
— Equals 1 to 24 for the 384-position tray

The following example is for the sample position C22 in a 384-position micro plate:

N=(3-1]x24)+22=48+22=70
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A

autosampler control terminal, using 22

c

cables
DB9 to DB9 serial cable 4
external contact trigger cable 12
PAL interface cable 12
Thermo Dual Configuration cable 10
Thermo Single Configuration cable 6
compliance
FCC iii
regulatory iii
WEEE v
computer requirements xi
contact closure connections
for a Thermo Scientific LC pump 7
for a Thermo Scientific MS 7
for an Agilent pump 12
for two Thermo Scientific pumps 10
contacting us xiii
control terminal attached to the autosampler 22
cycle composer macros 61
cycle composer macros or ICC cycles, installing 61
Cycle Editor 61

delay time 29
device drivers xi
Direct Control Configuration page 56
Direct Control dialog box, opening 51
DLW

characterizing features 59

cycle 72

cycle for fast injection 94

cycle for standard injection 72

fast injection cycle 66

operating 68

Thermo Scientific

overview 59

priming solvent lines 62

standard injection cycle 64
DLW Actuator/Solenoid 69
DLW Pumps 69

documentation survey xiv

E

electromagnetic compatibility iii

equation, sample position number in tray 112
error message, server failure xi

external contact board for Agilent pump 12

external contact closure cable connections 7

F

FCC compliance iii

file types
instrument methods (.meth) 29
macro (.pma) 45
templates (.pme) 36

ICC cycles 61

Injected screen on hand-held controller 24
Inlet Direct Control, opening 52
Instrument Configuration window 17

Instrument Setup WindOW, opening 26

J

Job Queue screen 23

L

level surface, importance of 2
lithium battery 1
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Index: M

Macro Editor

enabling 19

opening 43

page parameters 43
Macro, Instrument Setup 31
macros

creating 43

cycle composer 61

importing 20

list of standard 43
mass spectrometry applications ix
Menu screen 23
method parameters, specifying 26
method templates, list of 27

nomenclature for stacks, trays, and samples 107

numeric variables 48

0

object variables 48
ordering information 2
output signal to LC pump 5

P

parameters
Direct Control
Method page
Description 53
Device Status 53
Injections Per Vial 54
Injectors 54
Method 53
Syringe 53
Trays 54
Vial Index 54
Volume 54
Tray Configuration page
Tray 55
Tray Holder 56
Type 55
Vials in X Direction 56
Vials in Y Direction 56
Instrument Configuration 20
Auto Select 21
Browse 21
Check 21
Com Port 21
Enable 21
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Import 21
Import Path 21
Overwrite Existing Macros 21
Stack 22
Tray Name 22
Instrument Setup
Browse 30
Delay Time 31
Macro Sequence 30
Method Folder 30
New Template 30
Syringe 30
Template 30
Template Description 30
Variables 31
Volume 31
Macro Editor page
Add 45
Command 46
Command Description 47
Command Sequence 46
Delete 45-46
Edit 45
Insert Above 46
Insert Below 46
Macro 45
Macro Description 45
Macro Variables 45
Parameters 47
Replace 46
macros
Fast Injection Accela Open 66
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Stand Injection Accela Open 64
Run Auto Sampler Method dialog box
Injectors 40
Trays 40
Vial Index 40
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Template Editor page 35
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Default Value 49
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Variable Units 49
part numbers 2
priming solvent lines 62
pulse time of the out signals, setting 25
pumps, self-priming 60
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R W

Recommended Injection Volume box 29 Waiting for contact closure status for LC pump 24
regulatory compliance iii WEEE compliance v
release notes x
requirements
computer xi
software xi
Run Auto Sampler Method dialog box parameters 38

S

safety information 1

safety standards iii

sample trays 107
self-priming micro pumps 60
server failure error message xi
software requirements xi
solvent lines, priming 62, 68
stack, cooler 110

survey link xiv

syringe size, specifying 29
system requirements x

T

Template Editor
enabling 19
opening 35
Template Editor page parameters 35
templates
editing 35
Single Step LC Injection 27
testing 38
Thermo PAL driver for Xcalibur 61
Tray Configuration page 55
tray type, selecting with the PAL Control Terminal 23
Trays 40
trays
position in stack 110
sample position 111
type
DW96 108
MT384 109
MT96 108
VT54 107
Trays screen 23
Tune window, making single injections from 52
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